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ABSTRACT 

 

A study to generate three-dimensional (3D) reconstruction images of 

microstructures by using serial sectioning method is performed in which, proper 

processes and procedures of serial sectioning method need to be established. Serial 

sectioning method is a material-removal technique, which only practical for a range 

of material-removal rates of the materials to be studied. The basic serial sectioning 

material removal methods are involving manual or semiautomated polishing, which 

can remove between approximately 0.05 to 1.0 micron per section of the material. 

The material used in this project is Carbon Fiber Reinforced Polymer (CFRP) which 

is a very strong, light, and expensive composite material or fiber-reinforced 

polymer. In the project, a few tasks and experiments have been conducted including 

grinding and polishing, measuring by micrometer and image recording by using 

optical microscope. Both images from 5X magnification and 50X magnification  

have been successfully developed and reconstructed into 3D volume by using 

ImageJ computer software program. Several features and characteristics of CFRP 

which are the inclination angle measurement and fiber rich area are also discussed in 

a section of this report. 
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CHAPTER 1 

PROJECT BACKGROUND 

 

 

1.1 Background of Study 

 

3D analysis of microstructures already began at least from 1918 with Fortman’s 

effort to understand the 3D structure of pearlite. Solid models of cementite lamellas 

were constructed by him by projecting the images of each section onto cardboard 

layers of appropriate thickness. As the time goes by and technologies are developing 

rapidly, improvements in image processing and 3D visualization capabilities have 

made 3D reconstruction and visualization of microstructures much more practical. 

In 1991, Hull et al. were among the first to use computer software in the 3D analysis 

of microstructures. In this case, he used to contain the titanium prior-beta grain sizes 

and shapes into 3D wire-frame drawings. Probably, the first to take full advantage of 

advanced computer reconstruction of microstructures was Shiftlet’s group at the 

University of Virginia. (Kral et al., 1999) 

 

Nowadays, there are many methods that can be used to analyze the microstructures 

in 3D images such as serial sectioning, focused ion beam tomography, atom probe 

tomography and x-ray micro-tomography. However, in this project, the author is 

focusing more in the serial sectioning method in order to generate the 3D images of 

microstructures. 

 

1.2 Problems Identification 

 

Typically, two-dimensional (2D) metallographic methods provide single polished-

and-etched sections for observation and the 2D images of microstructures generated 

from these methods provide only a planar view of the material. Details of some 

parameters and characterizations of a microstructures or materials cannot be studied 

deeply due to this limitation. Thus, proper processes and procedures must be 

generated in order to obtain the 3D images of microstructures. By reconstructing the 

2D images, 3D volumes of microstructures can be generated to provide of more 
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precise descriptions of sizes, spatial distribution, shapes and interconnectivities of 

complex microstructural features which can be used in the detail studies of 

microstructures. 

 

Since the method of the reconstruction of 3D images of microstructures has not been 

widely developed yet in Malaysia, the author took the challenge to be one of the first 

to produce the official processes and procedures of 3D reconstruction of 

microstructures. 

 

1.3 Objectives and Scope of Study 

 

The main objective of this project is to generate three-dimensional (3D) 

reconstruction images of microstructures by using serial sectioning method. Also, 

proper processes and procedures of serial sectioning method need to be established 

as it is the method to be used in this project. 

 

The scope of study of the materials in this project are the materials that consist of 

minimum two phases. It can be the combination of ferrite and pearlite, austentite and 

ferrite or austentite and pearlite. Two phases materials are chosen because they have 

simple structures and is not too complicated to generate their volume. 

 

In order to complete this project, a few tasks and experiments need to be carried out. 

Grinding and polishing, measuring by micrometer and image recording by using 

optical microscope are the processes that need to be performed. Also, the uses of 

computer software are involved in order to generate the 3D volume of 

microstructures. 
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CHAPTER 2 

LITERATURE REVIEW 

 

 

2.1 Carbon Fiber Reinforced Polymer  

 

Carbon Fiber Reinforced Polymer (CFRP) is a Polymer Matrix Composite material 

reinforced by carbon fibers. The reinforcing dispersed phase may be in the form of 

either continuous or discontinuous carbon fibers commonly woven into a cloth. 

Carbon fibers are very expensive but they possess the highest specific mechanical 

properties such as modulus of elasticity and strength. Carbon fibers are used for 

reinforcing polymer matrix due to the following their properties: 

 Very high modulus of elasticity exceeding that of steel; 

 High tensile strength, which may reach 1000 ksi (7 GPa); 

 Low density: 114 lb/ft³ (1800 kg/m³); 

 High chemical inertness. (Kopeliovich, 2010) 

 

The types of carbon fibers are as follows: 

 UHM (ultra high modulus): Modulus of elasticity > 65400 ksi (450GPa). 

 HM (high modulus): Modulus of elasticity is in the range 51000-65400 ksi 

(350-450GPa). 

 IM (intermediate modulus): Modulus of elasticity is in the range 29000-

51000 ksi (200-350GPa). 

 HT (high tensile, low modulus): Tensile strength > 436 ksi (3 GPa), modulus 

of elasticity < 14500 ksi (100 GPa). 

 SHT (super high tensile). Tensile strength > 650 ksi (4.5GPa). (Kopeliovich, 

2010) 

 

Carbon fibers are also classified according to the manufacturing method: 

i. PAN-based carbon fibers (the most popular type of carbon fibers). 

In this method carbon fibers are produced by conversion of polyacrylonitrile 

(PAN) precursor through the following stages: 

http://www.substech.com/dokuwiki/doku.php?id=classification_of_composites&DokuWiki=395057fe1fbef30902e63efb638180c7
http://www.substech.com/dokuwiki/doku.php?id=tensile_test_and_stress-strain_diagram&DokuWiki=395057fe1fbef30902e63efb638180c7
http://www.substech.com/dokuwiki/doku.php?id=tensile_test_and_stress-strain_diagram&DokuWiki=395057fe1fbef30902e63efb638180c7
http://www.substech.com/dokuwiki/doku.php?id=steels_and_cast_irons&DokuWiki=395057fe1fbef30902e63efb638180c7
http://www.substech.com/dokuwiki/doku.php?id=tensile_test_and_stress-strain_diagram&DokuWiki=395057fe1fbef30902e63efb638180c7
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 Stretching filaments from polyacrylonitrile precursor and their thermal 

oxidation at 400°F (200°C). The filaments are held in tension. 

 Carbonization in Nitrogen atmosphere at a temperature about 2200 °F 

(1200°C) for several hours. During this stage non-carbon elements 

(O,N,H) volatilize resulting in enrichment of the fibers with carbon. 

 Graphitization at about 4500 °F (2500°C). 

ii. Pitch-based carbon fibers. 

Carbon fibers of this type are manufactured from pitch: 

 Filaments are spun from coal tar or petroleum asphalt (pitch). 

 The fibers are cured at 600°F (315°C). 

 Carbonization in nitrogen atmosphere at a temperature about 2200 °F 

(1200°C). (Kopeliovich, 2010) 

 

The most popular matrix materials for manufacturing Carbon Fiber Reinforced 

Polymers (CFRP) are thermosets such as epoxy, polyester and thermoplastics such 

as nylon (polyamide). Carbon Fiber Reinforced Polymers (CFRP) materials usually 

have laminate structure, providing reinforcing in two perpendicular directions. 

Carbon Fiber Reinforced Polymers (CFRP) are manufactured by open mold 

processes, closed mold processes and Pultrusion method. (Kopeliovich, 2010) 

 

Carbon Fiber Reinforced Polymers (CFRP) are characterized by the following 

properties: 

 Light weight; 

 High strength-to-weight ratio; 

 Very High modulus elasticity-to-weight ratio; 

 High Fatigue strength; 

 Good corrosion resistance; 

 Very low coefficient of thermal expansion; 

 Low impact resistance; 

 High electric conductivity; 

 High cost. 

 

http://www.substech.com/dokuwiki/doku.php?id=nitrogen&DokuWiki=395057fe1fbef30902e63efb638180c7
http://www.substech.com/dokuwiki/doku.php?id=fatigue&DokuWiki=395057fe1fbef30902e63efb638180c7
http://www.substech.com/dokuwiki/doku.php?id=corrosion_and_oxidation&DokuWiki=395057fe1fbef30902e63efb638180c7
http://www.substech.com/dokuwiki/doku.php?id=thermal_properties_of_ceramics&DokuWiki=395057fe1fbef30902e63efb638180c7#coefficient_of_thermal_expansion
http://www.substech.com/dokuwiki/doku.php?id=fracture_toughness&DokuWiki=395057fe1fbef30902e63efb638180c7#impact_test
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Carbon Fiber Reinforced Polymers (CFRP) are used for manufacturing: automotive 

marine and aerospace parts, sport goods (golf clubs, skis, tennis racquets, fishing 

rods), bicycle frames. The main disadvantage of carbon (Graphite) fibers is 

catastrophic mode of failure (carbon fibers are brittle). (Kopeliovich, 2010) 

 

2.2 Three-Dimensional (3D) Reconstruction Techniques 

 

When using traditional metallographic techniques, materials scientists often make 

assumptions about the shape, distribution and connectivity of 3D features that lie 

buried within the material. Recent work has shown that these assumptions can be 

incorrect. An approach to 3D analysis of microstructures has been taken nowadays 

and with recent improvements in image processing and 3D visualization capabilities 

which are helped by the computer-aided programs, many techniques to reconstruct 

the 3D volume of microstructures have been developed. Therefore, here are the brief 

descriptions of some of the techniques that are used in 3D reconstruction of 

microstructure. (Kral et al., 1999) 

 

2.2.1 Serial Sectioning 

 

Serial sectioning method is a material-removal technique, which is only practical for 

a range of material-removal rates of the materials to be studied. Anyone undertaking 

this project should identify a microstructural feature for which some 3D information 

is desired. The basic serial sectioning material removal methods involves manual or 

semiautomated polishing, which can usually remove approximately 0.05 to 1.0 

micron per section of the material. Also, there are other stages of experimental 

parameters that may be applicable in this techniques which are number of sections 

required, applying fiducial marks, etching requirements, images recording, images 

acquisition and visualization software. (Kral et al., 2004) 

 

2.2.2 Focused Ion Beam (FIB) Tomography 

 

In this technique, focused ion beam instruments are operated by rastering a focused 

beam of ions over the surface of the sample. Direct imaging of the sample surface is 

http://www.substech.com/dokuwiki/doku.php?id=graphite&DokuWiki=395057fe1fbef30902e63efb638180c7
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produced when there are interactions between the ion beam and the samples, and the 

interaction also result in material removal through sputtering. (Kral et al., 2004) 

 

For modern FIB systems, the ion beam spot sizes are routinely of the order of tens of 

nanometers. This means that these instruments are capable of both high-precision 

material removal and high-resolution imaging of microstructures. (Kral et al., 2004) 

 

2.2.3 Atom Probe Tomography 

 

In atom probe tomography, the sampled volume is reconstructed atom by atom from 

many hundred thousands of 2D layers, each of them contains a few atoms. A short-

duration high voltage pulse that is superimposed on a standing voltage is used to 

remove individual atoms from the surface of a needle-shaped specimen at a precise 

time. (Kral et al., 2004) 

 

Usually, a small aperture in the microchannel plate and phosphor screen assembly is 

used to view the field ion image in the original atom probe. However, in atom probe 

tomography technique, the volume analysis is defined by the number of layers of 

atoms field evaporated from the specimen and by the effective lateral extents of the 

position-sensitive detector. (Kral et al., 2004) 

 

 

2.2.4 X-Ray Microtomography 

 

X-Ray tomography is based on the realization that as an x-ray beam passes through 

an object, it samples a prismatic volume consisting of many small volume elements 

along its path. If some of the property of the sample such as attenuation of the beam 

density or the fluorescence yield is measured, it can be used to help reconstruct the 

structure along the beam path. (Kral et al., 2004) 

 

In order to accurately determine the internal structure of the object, different 

combination of the sample volume must be measured. With a small “pencil” beam, 

this is accomplished by translation and rotation of the sample. (Kral et al., 2004) 
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2.3 Three-Dimensional (3D) Reconstruction via Serial Sectioning  

 

The behavior of materials is controlled by their microstructure. The characteristics 

of a material’s microstructure, such as size, distribution, and morphology, control 

the mechanical and thermal behavior and properties of the material. Thus, 

establishing a link between microstructure and properties is vital to fully 

understanding and predicting material behavior. (Wunsch et al., 2003) 

 

A serial sectioning process has been developed to visualize and model the behavior 

of a material by using a computer reconstructed 3D microstructure. Two-

dimensional microstructures were acquired and used to develop 3D solids for 

visualization and finite-element modeling (FEM). Visualization and modeling of the 

3D composite microstructure aided in the understanding of microstructure 

morphology and provided the means to make the connection between material 

structure and performance. (Wunsch et al., 2003) 

 

Below are the brief descriptions of the experimental parameters involved in serial 

sectioning method. 

 

2.3.1 Specimen Mounting 

 

Samples are mounted primarily for ease in manipulation and for edge protection 

during preparation. There are many types of mounting that are available to be used 

in this project such as compression mounting, cold mounting and vacuum 

impregnation. However, cold mounting is the best technique of specimen mounting 

for this project. 

 

Three most common types of materials used in cold mounting are epoxide, 

polyesters and acrylics. These systems are all two component types which consist of 

a resin and hardener. Since an exothermic reaction during polymerization is 

involved, the mixing by volume or weight ratios of each system is critical. The 

epoxides are pale yellow and transparent, same goes to the polyesters which are 

transparent. However, the polyesters are also available in water clear or a slight pink 

hue while the acrylics are opaque. (Johnson, 1997) 
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2.3.2 Polishing and Etching 

 

In basic serial-sectioning material-removal method, manual or semiautomated 

polishing are involve which it can remove between 0.05 to 1.0 micron/section. In 

this project, the author decided to use 0.5 to 1.0 micron/section of interval for the 

removal rates of the material. In order to avoid and prevent pitting from continuing 

or even accelerating in the material, all pits are essentially removes during the 

subsequent polishing steps. (Kral et al., 2004) 

 

As for etching, this process may need to be performed to some materials and may 

not be to the others. Etching is required for some materials in order to obtain its 

sufficient contrast between phases subsequent to the removal of each layer. 

Problems may occur during this process such as inconsistent etching between layers, 

boundaries that do not respond due to their orientation and etching artifacts. (Kral et 

al., 2004) 

 

2.3.3 Applying Fiducial Marks 

 

Fiducial marks used in this project are microhardness indents which performed by 

using microhardness testing machines. Fiducial marks are used to align or register 

the images in the x-y plane and to track the actual material removal rate. Prior to the 

commencement of actual image acquisition, the material-removal rate may be 

calibrated by measuring the change in the diagonal length of an indent when the 

indent-to-depth ration is known. (Kral et al., 2004) 

 

2.3.4 Image Recording 

 

Digital optical micrographs can be obtained by using optical microscope. There are 

a number of digital cameras now available specifically for optical microscopy from 

manufacturers such as Olympus, Zeiss and Diagnostic Instrument. Scanning 

Electron Microscope (SEM) may also be used, although with a considerable increase 

in the time required to remove and insert the sample into a vacuum chamber for each 

section. Noted that pixels in a SEM are not square and unless there is a calibration 

and correction for the pixel aspect ratio, the sample must be placed into the SEM 
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chamber in the same orientation for each section to make subsequent registration 

more convenient. (Kral et al., 2004) 

 

2.3.5 Registration and Number of Sections Required. 

 

Alignment or registry of the serial sections can be manually performed by 

overlaying the fiducial marks in subsequent images. This process can be done 

through the use of image-processing software such as Adobe Photoshop and NIH 

Image. It may be faster to align automatically using microstructural features of 

individual cross section when the depth between sections is known and it can be 

determined from the fiducial marks, in this case the microhadness indents. (Kral et 

al, 2004) 

 

For the number of sections required, the scale of the features being studied and the 

limitations of the material-removal technique being used must be considered. The 

resolution of 3D presentation in every serial sectioning project has been limited by 

the thickness of each serial section layer. Thus, for this project, it is advisable to take 

from 50 to 100 sections of images. (Kral et al., 2004) 

 

2.4 Three-Dimensional (3D) Reconstruction Software 

 

Characterization of materials by analysis of 3D microstructures is placing a strong 

demand for visualization tools and techniques. Nowadays, there are many computer 

software packages currently available for 3D reconstruction and visualization. Some 

of the programs are “shareware” and “freeware” while others are commercially 

available. Table 1 illustrates some of the tools from the on-line sources. (Kral et al., 

1999) 
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Table 1: List of on-line sources for 3D visualization and techniques 

Website name URL Note 

Portable Pixel Map 

(PPM) 
sourceforge.net/projects/netpbm Image conversion 

NIH Image rsb.ibfo.nih.gov/nih-image 
Public domain 

preprocessing 

Aphelion Hallogram.com/apheliondev Commercial 

Noesis Images www.norpix.com/visilog.htm Commercial 

WorkSpace www.fakespacesystems.com/index.htm Virtual reality 

CAVE,NCSA www.vrco.com/ Virtual reality 

Juggle, Iowa State www.vrjuggler.org Virtual reality 

Amira, Template 

Graphics, Inc. (TGS) 
www.amiravis.com/ 

Commercial 

algorithm 

SCIRun, University 

of Utah 
software.sci.utah.edu/scirun.html 

Public domain ray 

tracing 

Volpack, Stanford 

University 
graphics.stanford.edu/software/volpack 

Public domain ray 

tracing 

Gnu Image 

Manipulation 

Program (GIMP) 

www.gimp.org Image processing 

Paint.NET http://www.getpaint.net/ Image processing 

ImageJ http://rsbweb.nih.gov/ij/ Image processing 

 

2.4.1 Gnu Image Manipulation Program (GIMP) 

GIMP is an acronym for GNU Image Manipulation Program. It is a freely 

distributed program for such tasks as photo retouching, image composition and 

image authoring. In the free software world, there is generally no distinction 

between users and developers. It has many capabilities. It can be used as a simple 

paint program, an expert quality photo retouching program, an online batch 

processing system, a mass production image renderer, an image format converter, 

etc.  

http://www.norpix.com/visilog.htm
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GIMP is expandable and extensible. It is designed to be augmented with plug-ins 

and extensions to do just about anything. The advanced scripting interface allows 

everything from the simplest task to the most complex image manipulation 

procedures to be easily scripted. 

GIMP is written and developed under X11 on UNIX platforms. But basically the 

same code also runs on MS Windows and Mac OS X. 

2.4.2 Paint.NET 

Paint.NET is a free image and photo editing software for computers that run 

Microsoft Windows, developed on the .NET Framework. Originally created as a 

Washington State University student project, Paint.NET has evolved from a simple 

replacement for the Microsoft Paint program, which is included with Windows, into 

a powerful editor with support for layers, blending, transparency, and plug-in. It is 

often used as a free alternative to Adobe Photoshop. 

It features an intuitive and innovative user interface with support for layers, 

unlimited undo, special effects, and a wide variety of useful and powerful tools. An 

active and growing online community provides friendly help, tutorials, and plug-in. 

2.4.3 ImageJ 

ImageJ is a public domain Java image processing program inspired by NIH Image 

for the Macintosh. It runs, either as an online applet or as a downloadable 

application, on any computer with a Java 1.4 or later virtual machine. Downloadable 

distributions are available for Windows, Mac OS, Mac OS X and Linux. 

It can display, edit, analyze, process, save and print 8-bit, 16-bit and 32-bit images. 

It can read many image formats including TIFF, GIF, JPEG, BMP, DICOM, FITS 

and "raw". It supports "stacks", a series of images that share a single window. It is 

multithreaded, so time-consuming operations such as image file reading can be 

performed in parallel with other operations. 

It can calculate area and pixel value statistics of user-defined selections. It can 

measure distances and angles as well. Besides, it can create density histograms and 

http://www.gimp.org/unix/
http://www.gimp.org/windows/
http://www.gimp.org/macintosh/
http://www.getpaint.net/
http://en.wikipedia.org/wiki/Microsoft_Windows
http://en.wikipedia.org/wiki/.NET_Framework
http://en.wikipedia.org/wiki/Washington_State_University
http://en.wikipedia.org/wiki/Microsoft_Paint
http://en.wikipedia.org/wiki/Adobe_Photoshop
http://www.getpaint.net/features.html
http://www.getpaint.net/redirect/forum.html
http://www.getpaint.net/redirect/tutorials.html
http://www.getpaint.net/redirect/plugins.html
http://rsb.info.nih.gov/nih-image/
http://rsb.info.nih.gov/ij/download.html
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line profile plots. It also supports standard image processing functions such as 

contrast manipulation, sharpening, smoothing, edge detection and median filtering.  

It does geometric transformations such as scaling, rotation and flips. Image can be 

zoomed up to 32:1 and down to 1:32. All analysis and processing functions are 

available at any magnification factor. The program supports any number of windows 

(images) simultaneously, limited only by available memory. Spatial calibration is 

available to provide real world dimensional measurements in units such as 

millimeters. Density or gray scale calibration is also available. 

ImageJ was designed with an open architecture that provides extensibility via Java 

plugins. Custom acquisition, analysis and processing plugins can be developed using 

ImageJ's built in editor and Java compiler. User-written plugins make it possible to 

solve almost any image processing or analysis problem. 
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CHAPTER 3 

METHODOLOGY 

3.1 Flow Chart 

Figure 1 summarizes the serial section process flow for CFRP. 

 

 

Figure 1: The serial sectioning process flow chart for CFRP 

? 

? 
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The project started with the selection of material which is the Carbon Fiber 

Reinforced Polymer (CFRP). Then, it is continued with specimen mounting, where 

cold mounting is selected to be used instead of hot mounting. Next, the most crucial 

step is the polishing process. About one to one and half hour are needed to prepare a 

single layer of the material. After that, the specimen is measured by using 

micrometer. If there is insufficient depth of removed material, polishing process 

need to be repeated until the desired depth is removed. Once the sufficient depth is 

obtained, 2D images are acquired by using optical microscope. Sufficient numbers 

of layers need to be obtained so this stage must be repeated. The last stage of the 

project work is the 3D image reconstruction. This process requires the use of 

computer software program which is ImageJ. The project is ended once the final 

stage is completed. 

 

3.2 Project Activities 

 

3.2.1 Material Selection 

 

The material used in this project is Carbon Fiber Reinforced Polymer (CFRP). 

Carbon Fiber Reinforced Polymer is a very strong, light, and expensive composite 

material or fiber-reinforced polymer. The composite material is commonly referred 

to by the name of its reinforcing fibers (carbon fiber). The polymer is most 

often epoxy, but other polymers, such as polyester, vinyl ester or nylon are 

sometimes used. Some composites contain both carbon fiber and other fibers such as 

Kevlar, aluminum and fiberglass reinforcement.  

 

It has many applications in aerospace and automotive fields, as well as in sailboats, 

and notably in modern bicycles and motorcycles, where its high strength-to-weight 

ratio is of importance. Improved manufacturing techniques are reducing the costs 

and time to manufacture, making it increasingly common in small consumer goods 

as well, such as laptops, tripod, fishing rods, paintball equipment, archery 

equipment, racquet frames, stringed instrument bodies, classical guitar string, drum 

shells, golf clubs, and pool/billiard/snooker cues. 
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3.2.2 Specimen Mounting 

 

There are three types of common materials used in cold mounting which are 

polyesters, epoxides and acrylics. In this project, epoxide is the material chosen for 

cold mounting of a sample. Below are the procedures of mounting a specimen by 

using Epo-Kwick Fast Cure Epoxy Kit. 

 

i. A scale mix by weight must be used which is five parts Epo-Kwick Resin to 

one part Epo-Kwick Hardener. 

ii. The samples are cleaned and dried thoroughly before encapsulation 

iii. The inside of the mounting cup is coated with Release Agent (20-8185) to 

ensure easy removal of the mount from the mold. 

iv. The specimen is placed inside the center of the mounting cup with the 

surface of interest facing down. 

v. The mixture is blended thoroughly for approximately 1 – 1.5 minutes. 

 For best result, the cup containing the resin and hardener is tipped 

slightly and by using a stirring stick, the resin and hardener are gently 

work together using a lift and stir motion until the mixture is thoroughly 

blended. 

 The mix will start out cloudy as the resin and hardener are blended 

together. The mixture is kept blended until it becomes clear, indicating it 

is thoroughly mixed. 

 Violent stirring must be avoided in order to prevent the formation of air 

bubbles. 

 

Figure 2: Technique of stirring the mixture. 
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vi. Once the mixture is clear, it is poured into the mounting cup to near capacity 

of best result. 

vii. The mold is allowed to cure at room temperature for approximately 12 hours. 

viii. After curing, the mount is removed from the mounting cup. 

 

 

Figure 3: Epo-Kwick Fast Cure Epoxy Kit. 

 

3.2.3 Polishing 

 

For this project purposes, METASERV 2000 Grinder and Polisher are used and 

there are procedures of grinding and polishing that need to be followed. The 

procedures are as stated below: 

 

i. The mounted sample must be grinded by using 240 grit of Silicon Carbide 

(SiC) with water as lubricant for the first step. 

ii. The mount is cleaned thoroughly and dried. 

iii. Step i is repeated by using 320, 400 and 600 grit of SiC with water as 

lubricant and sample is rotated 90º during the process. 

iv. The mount is cleaned thoroughly by using cotton swab saturated with 

alcohol and dried. 

v. Step i is repeated by using precondition synthetic velvet cloth with six 

micron diamond paste and a water soluble extender as lubricant. 

vi. Polishing continued by using three micron diamond paste and one micron 

diamond paste. 
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vii. If the removal depth is not achieved, the polishing process is repeated with 

P1200 grade of SiC, followed by P2400, P4000, three micron diamond paste 

and one micron diamond paste. 

viii. Step vii is continued until the desired removal depth is removed. 

ix. Sample must be rotated 90º during each grade of polishing processes. 

 

 

Figure 4: METASERV 2000 Grinder and Polisher. 

 

3.2.4 Measuring Removal Depth 

 

In order to measure the depth or removed material, Mitutoyo Micrometer is used. 

Below are the steps in using the micrometer. 

 

i. The sample is located between anvil and spindle of the micrometer. 

ii. The micrometer is closed by rotating its thimble and make sure that the 

interested surface is situated between the anvil and spindle surface. 

iii. The ratchet is spin until the spindle meets the sample. 

iv. The ratchet is spin until 3 clicks are heard. 

v. Both the anvil and spindle are verified to touch the object evenly. 

vi. The thimble lock is set while the micrometer is still on the object. 

vii. The micrometer is removed from the object once it's been locked. 

viii. The initial reading of micrometer is taken. 

ix. After the sample has been polished for the next layer, step i to vii are 

repeated. 
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x. The current reading is taken. 

xi. The current data must be deducted from the initial reading in order to get the 

depth of removed material 

xii. Step ix to xi is repeated for the next number of layers. 

 

Figure 5: Mitutoyo Micrometer (103-137 M110-25). 

 

3.2.5 Acquiring 2D Images 

 

In this project, Leica DMLM Optical Microscope is employed in order to capture the 

2D images of the sample. Here are the steps and procedures to use the optical 

microscope; 

 

i. The optical microscope is set as per settings below; 

 A = 2.25 

 F = 1.75 

 No polarizer 

 Optimum exposed light = between 10 and 11 

 DLF = Up 

 BG20 and gwin = Down 

ii. The computer software, DinoCapture is set as per settings below; 

 Image mirror = Untick (X) 

 Image Flip = Untick  (X) 

 Low Light = Tick (/) 

 Brightness = 126 

 Contrast =1.45 

 Gamma = 0.70 
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 Hue = 35 

 Saturation = 2.20 

 Sharpness = 4.50 

 Exposure = 80 

 Red = 1.00 

 Blue = 1.00 

iii. The sample is placed on the microscope stage, with the specimen directly 

over the center of the glass circle on the stage (directly over the light). 

iv. If the image is on low power (unfocused),  the position of diaphragm is 

adjusted by raising it to the objective lens 

v. It is focused by using first the coarse knob, then the fine focus knob until 

the image appeared 

vi. Once the image is appeared, the “capture” button is clicked at the 

DinoCapture software. 

vii. Step iii-vi is repeated for the other desired area of the sample. 

viii. Step iii-vi is also repeated for 50X magnification objective lens. 

 

 

Figure 6: Leica DMLM Optical Microscope 
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3.2.6 3D Reconstruction 

 

3D volume reconstruction of the material is fully done by using ImageJ computer 

program. Below are the steps taken in order to develop the volumes. 

 

i. Open all the 2D images as an image sequence (File > Import > Image 

Sequence) 

ii. Make sure to tick the “Convert to 8-bit Grayscale” box. 

iii. Align all the images by using ImageJ plugins. Make sure to install the 

StackReg plugin first. (Plugins > Stackreg > StackReg) 

iv. Crop the aligned images. (Image > Crop) 

v. Set the threshold of the images. Make sure the colours of the images turn to 

black and white. (Image > Adjust > Threshold) 

vi. Invert the colours (Edit > Invert) 

vii. Set the properties of the images (Image > Properties) 

viii. Finally, reconstruct those 2D images by using ImageJ 3D Volume Viewer 

plugin (Plugins > 3D > ImageJ 3D Volume Viewer > Select the white colour 

in appeared box) 

 

3.3 Equipments and Computer Software 

The equipments and computer software that are used for this project are as below. 

 

Table 2: List of equipments and computer software used in this project 

Equipments Computer softwares 

Epo-Kwick Fast Cure Epoxy Kit. DinoCapture 

METASERV 2000 Grinder and 

Polisher. 

ImageJ 

Mitutoyo Micrometer 

(103-137 M110-25) 

 

Leica DMLM Optical Microscope  



21 

 

3.4 Gannt Chart 

Detail / Week 1  2  3  4  5  6  7  
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polishing and grinding 
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Progress Report 1 

              

Project continues on 

Computer Aided 

program for 
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Submission of 

Progress Report 2 

              

Seminar               

Poster Exhibition               

Submission of 

Dissertation Final 

Draft 

              

Oral Presentation               

Submission of 

Dissertation 

(hard bound) 

       

7 days after oral presentation  

Figure 7: Gantt chart for Three-Dimensional (3D) Reconstruction of Microstructures via Serial Sectioning project. 
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CHAPTER 4 

RESULTS AND DISCUSSIONS 

 

4.1 Work completed and Data Presentation 

 

 

Nine sections of images from the specimen need to be taken with 5X magnification 

and a section with 50 X magnification for each layer. Also, around 30 to 50 layers of 

specimens in 2D images with 20 to 40 micron interval are needed in this project. 

Time taken is about one and a half hour for the process of polishing and grinding 

and also including the process of acquiring 2D images to be completed. 

 

Figures below show the layout of nine sections of images from specimen that would 

be taken with 5X magnification and a section with 50X magnification. 

 

 

 

 

 

 

 

 

 

 

Figure 8: Nine sections of images of specimen with 5X magnification. 
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Figure 9: Area of a section with 50X magnification. 

 

There are four locations need to be measured by micrometer in order to calculate the 

average material removal rate of the specimen after the polishing and grinding 

process. Figure 6 and Table 2 below show the location of measurement and the data 

gathered. 

 

 

 

 

 

 

 

 

Figure 10: Four locations of measurement.  
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Table 3: Data gathered for average material removal rate. 

 

No. of 

layer Specimen Thickness (mm) 

Average Material 

Removal Rate 

  1 2 3 4 (mm) 

1 11.98 11.97 11.96 11.94 0.000 

2 11.91 11.92 11.93 11.92 0.043 

3 11.86 11.88 11.88 11.87 0.047 

4 11.82 11.84 11.84 11.82 0.043 

5 11.78 11.80 11.81 11.78 0.037 

6 11.74 11.76 11.79 11.74 0.035 

7 11.70 11.70 11.77 11.70 0.040 

8 11.31 11.33 11.33 11.33 0.093 

9 11.27 11.29 11.29 11.29 0.041 

10 11.23 11.27 11.28 11.26 0.026 

11 11.20 11.24 11.24 11.23 0.030 

12 11.08 11.12 11.11 11.10 0.126 

13 11.01 11.04 11.05 11.04 0.069 

14 10.97 11.01 11.03 11.01 0.029 

15 10.92 10.97 10.98 10.96 0.049 

16 10.90 10.93 10.94 10.92 0.033 

17 10.88 10.90 10.91 10.90 0.025 

18 10.86 10.88 10.89 10.80 0.040 

19 10.84 10.87 10.87 10.85 0.013 

20 10.81 10.84 10.83 10.82 0.020 

21 10.78 10.81 10.80 10.78 0.032 

22 10.75 10.78 10.78 10.76 0.025 

23 10.72 10.76 10.76 10.73 0.025 

24 10.70 10.74 10.74 10.70 0.023 

25 10.66 10.72 10.72 10.65 0.032 

26 10.62 10.68 10.68 10.61 0.040 

27 10.58 10.65 10.66 10.58 0.030 

28 10.54 10.63 10.62 10.54 0.035 

29 10.51 10.61 10.60 10.50 0.027 

30 10.48 10.58 10.58 10.47 0.027 
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There are nine sections of 2D images that need to be taken with 5X magnification 

and a section with 50X magnification. Here are the sample images from the second 

layer of the specimen with specified magnification. 

 

 
Section C 

 
Section B 

 
Section A 

 
Section D 

 
Section E 

 
Section F 

 
Section I 

 
Section H 

 
Section G 

 

Figure 11: Nine sections of 2D images from the specimen with 5X magnification 

(second layer) 



26 

 

 

Figure 12: A 2D image from the specimen with 50X magnification. 

 

There are 261 2D images for 5X magnification and 30 2D images of 50X 

magnification in total. For 5X magnification 2D images, they will be reconstructed 

to 3D volume by each section and same goes to 50X magnification. All 2D images 

are reconstructed by using computer software which is ImageJ. 

 

The steps to develop those 3D volumes of CFRP have been described in Project 

Activities Section 3.2.6. Some characteristics of the CFRP can be seen in these 3D 

images in which, very useful in the study of this material. The importance of those 

characteristics will be discussed later in the Discussion section. Here are some 

figures that show the 3D volume reconstructed by this software. 
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Figure 13: 3D (2394 x 1043 x 380 micron) volume of CFRP that are reconstructed 

from 50X magnification. 
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Figure 14: 3D (7094 x 2981 x 1100 micron) volume of CFRP that are reconstructed 

from Section C of 5X magnification. 
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4.2 Data Analysis 

 

4.2.1 Angle Measurement by ImageJ 

 

 

Figure 15: Three sides of sample for angle measurement purpose (2394 x 1043 x 

380 micron). 

 

For this project purpose, three sides as indicated in figure above are selected in order 

to measure some angles of the fibers. All measurements of angles are performed by 

using ImageJ computer software and angle measurement steps are as follows. 

 

i. Go to File, and open samples. 

ii. Take Angle Tool and click on one length of the open angle. 

iii. Draw the line down to the apex and then out the other length. 

iv. Go up to Analyze, click on Measure. 

v. A set of result should be appeared including the angle of the line drawn. 

 

Several positions of fibers are selected and their results are shown in figures and 

tables below. 

 

Side A 

Side B 

Side C 
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Figure 16: Side A of fibers angle measurement. 

 

Table 4: Angle of fibers calculated by ImageJ for Side A 

Position Angle ( ° ) 

1 35.12 

2 39.71 

3 35.10 

 

 

Figure 17: Side B of fibers angle measurement. 

 

Table 5: Angle of fibers calculated by ImageJ for Side B 

Position Angle ( ° ) 

1 11.31 

2 7.72 

3 49.31 

4 48.30 

5 36.06 

 

1 2 3 

1 2 

5 4 3 
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Figure 18: Side C of fibers angle measurement. 

 

Table 6: Angle of fibers calculated by ImageJ for Side C 

Position Angle ( ° ) 

1 12.01 

2 8.12 

3 10.97 

4 18.79 

 

4.2.2 Angle Measurement by Tracking a Fiber 

 

This technique of angle measurement requires both of computer software feed and 

simple calculation based on Pythagorean Theorem. 

 

 

Figure 19: Five selected fibers to be tracked 

As for this project purpose, five carbon fibers are selected as shown in Figure 14. 

Then by using ImageJ, each fiber is tracked down up to nine layers to see their 

2 1 4 3 

Fiber A Fiber B Fiber D Fiber C Fiber E 



32 

 

orientation. The steps involved in tracking down the fibers and necessary 

information gathered are explained in set of procedures below. 

 

i. The aligned of 2D images of 50X magnification is opened. (File > Open) 

ii. Preferred fiber is cropped out form the image by using rectangle tool. 

(Rectangle Tool > Select the area of preferred fiber > Image > Crop) 

iii. Separate the image sequence into a set of image files to create a new image 

sequence. (Image > Stacks > Stacks to Image) 

iv. Save all the 9 first layers in a folder by alphabetical order. 

v. Create a new image sequence. (Open > Image Sequence > Select one of the 9 

layers saved) 

vi. Select a point on the fiber. Create a line from the point of the first layer to the 

same point of second layer. 

vii. Measure the length of the line. (Analyze > Measure) 

viii. Repeat step vii to viii up to 9 layers. 

 

 
1

st
 

Layer 

 
2

nd
 

Layer 

 
3
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Layer 

 
4

th
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9
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Figure 20: Set of tracking images for Fiber E. 

 

From the length measured and depth removed between layers, Pythagoras Theorem 

is employed in order to determine the angle of the fibers. A picture of this 

calculation concept is shown in Figure 16 for better understanding. 
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Figure 21: Pythagoras Theorem principle in measuring inclination angle. 

 

Thus, in order to calculate the inclination angle, ϴ the following equation are used. 

 

ϴ  =  tan
-1

 (L / D) 

Where;  ϴ = Inclination angle 

  L = Length of fiber movement 

   D = Depth of removed material 

Assumptions: Diameter of a fiber = 2 µm 

 

Sample calculation for second layer of Fiber A; 

ϴ  =  tan
-1

 (L / D) 

 = tan
-1

 (0.2371 / 43) 

 = tan
-1

 (0.0055) 

 = 0.32
O 

 

 

 

 

 

 

 

 

 

Length of fiber 

movement, L 

Depth of removed 

material, D 

Inclination 

angle, ϴ 

 

Fiber at first layer 

Fiber at second layer 
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Table 7: Data gathered for angle measurement by using tracking fiber method. 

Carbon Fiber Layer L (µm) D (µm) L / D ϴ ( 
O

 ) 

Fiber A 1 0.00 0.00 0.00 0.00 

 2 0.24 43.00 0.01 0.32 

 3 0.34 47.00 0.0072 0.41 

 4 0.37 43.00 0.0086 0.49 

 5 0.19 37.00 0.0052 0.30 

 6 0.19 35.00 0.0055 0.32 

 7 0.00 4.00 0.0000 0.00 

 8 0.24 393.00 0.0006 0.03 

 9 0.499 41.00 0.0119 0.68 

Fiber B 1 0.00 0.00 0.0000 0.00 

 2 0.40 43.00 0.0093 0.53 

 3 0.33 47.00 0.0071 0.41 

 4 0.64 43.00 0.0148 0.85 

 5 0.33 37.00 0.0090 0.52 

 6 0.37 35.00 0.0107 0.61 

 7 0.00 4.00 0.0000 0.00 

 8 0.00 393.00 0.0000 0.00 

 9 0.59 41.00 0.0145 0.83 

Fiber C 1 0.00 0.00 0.0000 0.00 

 2 0.36 43.00 0.0084 0.48 

 3 0.37 47.00 0.0079 0.45 

 4 0.65 43.00 0.0151 0.87 

 5 0.59 37.00 0.0159 0.91 

 6 0.38 35.00 0.0108 0.62 

 7 0.00 4.00 0.0000 0.00 

 8 0.00 393.00 0.0000 0.00 

 9 0.39 41.00 0.0096 0.55 

Fiber D 1 0.00 0.00 0.0000 0.00 

 2 0.24 43.00 0.0056 0.32 

 3 0.24 47.00 0.0050 0.29 

 4 0.41 43.00 0.0095 0.54 

 5 0.26 37.00 0.0070 0.40 

 6 0.24 35.00 0.0069 0.40 

 7 0.00 4.00 0.0000 0.00 

 8 0.00 393.00 0.0000 0.00 

 9 0.47 41.00 0.0115 0.66 

Fiber E 1 0.00 0.00 0.0000 0.00 

 2 0.24 43.00 0.0055 0.32 

 3 0.34 47.00 0.0072 0.42 

 4 0.50 43.00 0.0117 0.67 

 5 0.34 37.00 0.0091 0.52 

 6 0.30 35.00 0.0087 0.50 

 7 0.00 4.00 0.0000 0.00 

 8 0.00 393.00 0.0000 0.00 

 9 0.54 41.00 0.0132 0.76 
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Figure 22: Graph of Inclination Angle vs Number of Layers 

 

The inclination angle of fiber is an important characteristic of a material. With 2
O
 of 

inclination angle, it will give effect of 30% of compression strength reduction of 

CFRP. Also, with the increase of fiber inclination angle, fiber apparent strength will 

decrease.  

 

Up to 9 layers are used for this project as the tenth layer of the sample is misaligned 

thus disturbing the orientation of the fibers. However, the 3D volume is continued to 

be developed for the next number of layers since all of them are properly aligned by 

using the computer software, ImageJ. 

 

From the data gathered, all the inclination angles of the fibers for this CFRP sample 

is less than 1
O
. The highest inclination angle is 0.9109

O
 and the lowest is 0.0343

O
. 

Thus, it can be considered that this sample is still strong enough to be used in 

industry.  

 

 

 

 

 

Inclination Angle VS Number of Layer 
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4.2.3 Fiber-Rich Area and Resin-Rich Area 

  

After developing the 3D volume of the material, there are some important features 

that need to be considered. Two of these features are the fiber-rich and resin-rich 

areas.  

 

It is always assumed that the fibers will evenly distribute in the whole composite. 

However, based on the 3D images developed through serial sectioning method, there 

are some areas full of fibers and other parts that are rich with resin. This condition 

will affect the strength of the material as there is no reinforcement in the resin rich 

area. It may become a weak location of the material and this condition is critical, 

since CFRP will be used in wide application such as in automotive, aircraft and also 

in military applications. 

 

These features can be seen clearly using 3D reconstructed image whereas 2D images 

might not be as convincing. Figures 23 - 25 are attached together in this report that 

shows the fiber-rich area and resin-rich area from some sections of CFRP sample. 

 

 

Figure 23: Resin-rich area from 3D (8479 x 2644 x 1100 miccron) volume of 

Section-B 

Fiber Glass 

Resin Rich Area 
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Figure 24: Resin-rich area from 3D (7094 x 2981 x 1100 micron) volume of 

Section-C 

 

 

Figure 25: Resin-rich area from 3D (8325 x 2600x 1100 micron) volume of 

Section-H 

 

Fiber Glass 

Resin Rich Area 

Fiber Glass 

Resin Rich Area 
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CHAPTER 5 

CONCLUSION AND RECOMMENDATIONS 

 

As for the conclusion, the main objective of this project have been achieved which is 

to generate the three dimensional image of microstructures. Both images from 5X 

magnification and 50X magnification have been successfully developed and 

reconstructed into 3D volume by using ImageJ computer software program. 

 

Also, proper processes and procedures to generate these 3D volumes have been 

established by the author in Methodology Section 3.2 Project Activities. Besides, 

some features and characteristics of CFRP which are the inclination angle 

measurements and fiber-rich areas have also been discussed by the author in this 

report. 

 

For mounting process, it is advised to blend the mixture of resin and hardener more 

gently in order to avoid air to be trapped inside the mounting. Otherwise, vacuum 

can be used to remove the entrapped air. The ratio of mixture must be followed 

correctly which is five parts resin to one part hardener and the mixture must be 

blended completely. This is to prevent defects such as cracking and soft mounts to 

occur. Last but not least, the container should be tightly sealed to divert discoloring.  

 

During polishing, it is necessary to grind both surfaces until become flat surface in 

order to ensure the sample can manage to stand still. Thus, errors can be avoided 

during the measuring and acquiring image process by using optical microscope. For 

silicon carbide disk, steady stream of water will facilitate the polishing process and 

it is important to always ultrasonically clean samples between polishing steps to 

minimize contaminations. 

 

As for measuring process, the zero error of the micrometer should be recorded and 

the value need to be deducted then with the readings obtained in order to get the 

actual depth of the removal rate. Also, the thimble should not be rotated more after 

its anvil and spindle have reached the surface of the material as this will damage the 
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device itself. It is just necessary to rotate the ratchet until 3 clicks are heard when the 

surface of material has touched the anvil and spindle surface. 

 

Usually, the measurement of material removal rate is done based on fiducial marks. 

However, using fiducial marks on CFRP is not applicable due to the elasticity of this 

material. The fibers tend to get back to their earlier shape after the indenter is 

removed. The mark still can be seen but not in the desired shape which can be used 

to calculate the depth of material removed. Thus, micrometer is chosen in this 

project in order to measure the depth of removed material. 

 

In acquiring 2D images, the optical microscope and the computer software are set 

with appropriate setting that is suitable with the material surface. All settings need to 

be saved and make sure to use the same settings when recording the next number of 

layers. All layers should be used in the same settings of optical microscope and 

computer software program in order to synchronize the colors and appearance of the 

images taken. Hence, the process of 3D reconstruction by ImageJ would be easier. 
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Figure 26: 9 sections of 2D images from the specimen with 5X magnification (1st 

layer) 
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Figure 27: 9 sections of 2D images from the specimen with 5X magnification (2nd 

layer) 
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Figure 28: 9 sections of 2D images from the specimen with 5X magnification (3rd 

layer) 
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Figure 29: 9 sections of 2D images from the specimen with 5X magnification (4th 

layer) 
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Figure 30: 9 sections of 2D images from the specimen with 5X magnification (5th 

layer) 
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Figure 31: 9 sections of 2D images from the specimen with 5X magnification (6th 

layer) 
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Figure 32: 9 sections of 2D images from the specimen with 5X magnification (7th 

layer) 
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Figure 33: 9 sections of 2D images from the specimen with 5X magnification (9th 

layer) 
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Figure 34: 9 sections of 2D images from the specimen with 5X magnification (11th 

layer) 
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Figure 35: 9 sections of 2D images from the specimen with 5X magnification (12th 

layer) 
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Figure 36: 9 sections of 2D images from the specimen with 5X magnification (13th 

layer) 
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Figure 37: 9 sections of 2D images from the specimen with 5X magnification (14th 

layer) 
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Figure 38: 9 sections of 2D images from the specimen with 5X magnification (15th 

layer) 

 
Section C 

 
Section B 

 
Section A 



49 

 

 
Section D 

 
Section E 

 
Section F 

 
Section I 

 
Section H 

 
Section G 

Figure 39: 9 sections of 2D images from the specimen with 5X magnification 

(second layer) 
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Figure 40: 9 sections of 2D images from the specimen with 5X magnification (17th 

layer) 
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Figure 41: 9 sections of 2D images from the specimen with 5X magnification (18th 

layer) 
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Figure 42: 9 sections of 2D images from the specimen with 5X magnification (19th 

layer) 
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Figure 43: 9 sections of 2D images from the specimen with 5X magnification (20th 

layer) 
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Figure 44: 9 sections of 2D images from the specimen with 5X magnification (21st 

layer) 
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Figure 45: 9 sections of 2D images from the specimen with 5X magnification (22nd 

layer) 
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Figure 46: 9 sections of 2D images from the specimen with 5X magnification (23rd 

layer) 
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Figure 47: 9 sections of 2D images from the specimen with 5X magnification (24th 

layer) 
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Figure 48: 9 sections of 2D images from the specimen with 5X magnification (25th 

layer) 
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Figure 49: 9 sections of 2D images from the specimen with 5X magnification (26th 

layer) 
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Figure 50: 9 sections of 2D images from the specimen with 5X magnification (27th 

layer) 
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Figure 51: 9 sections of 2D images from the specimen with 5X magnification (28th 

layer) 
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Figure 52: 9 sections of 2D images from the specimen with 5X magnification (29th 

layer) 

 
Section C 

 
Section B 

 
Section A 

 
Section D 

 
Section E 

 
Section F 

 

 

 
Section H 

 
Section G 

Figure 53: 9 sections of 2D images from the specimen with 5X magnification (30th 

layer) 
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Figure 54: 28 layers of 2D images from the specimen with 50X magnification  
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Figure 55: 3D volume of 5X magnification  for Section A 
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Figure 56: 3D volume of 5X magnification  for Section B 
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Figure 55: 3D volume of 5X magnification  for Section C 
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Figure 55: 3D volume of 5X magnification  for Section D 
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Figure 55: 3D volume of 5X magnification  for Section F 
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Figure 55: 3D volume of 5X magnification  for Section H 
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Figure 55: 3D volume of 5X magnification  for Section I 
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